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Overview and Requirements

 

Apple Xserve Diagnostics tests your Intel-based Xserve for 
hardware issues.

 

Apple Xserve Diagnostics (AXD) runs a customizable set of tests to help you diagnose 
issues with the following:
Â

 

Boot ROM
Â

 

Ethernet controller
Â

 

Fan
Â

 

Hard drive
Â

 

Memory
Â

 

Power supply
Â

 

Processor
Â

 

Sensor
Â

 

USB ports
Â

 

Video controller

You can run AXD in Extensible Firmware Interface (EFI), which is referred to as 

 

AXD EFI 
tools

 

, or in Mac OS X or Mac OS X Server, which is referred to as 

 

AXD Mac OS X tools

 

.

By running AXD EFI tools, you can diagnose hardware issues that prevent Mac OS X 
Server from successfully loading. You can also run tests without interference from 
Mac OS X Server and test more than 2.5 gigabytes (GB) of memory. However, AXD 
Mac OS X tools provides an enhanced interface and has more extensive sensor, fan, 
hard drive, and video controller tests. For a detailed comparison and description of all 
available tests, see the appendix, “AXD Tools Test Reference” on page 29.

You can test the Xserve itself by running AXD tools on it. You can also run it on a 
computer that has a network connection to the Xserve and remotely control the 
Xserve.



 

Chapter 1   

 

 Overview and Requirements

 

5

 

 

 

Note:  

 

This guide describes how to use AXD version 3X102. If you’re using a different 
version of AXD, the instructions in this guide might not work. AXD version 3X102 is 
included in Mac OS X Server Administration Tools version 10.4.10 and later. You can find 
out which version of AXD tools you’re running by opening AXD Mac OS X tools and 
choosing AXD > About Apple Xserve Diagnostics.

 

Overview of AXD Configurations

 

You can install and run AXD in a variety of ways, so it’s important that you choose the 
method that best suits your needs.

There are several AXD configuration options with distinct considerations:

 

Option Considerations

 

Host a NetBoot server Advantages:
Â

 

Don’t need to install AXD on an internal volume on the Xserve or 
on a portable storage device

Â

 

Can test multiple Xserves using the same AXD install image
Â

 

Allows you to use AXD EFI tools
Â

 

You can load AXD tools without an input device connected to the 
Xserve (if you have access to the Xserve’s front panel)

Disadvantages:
Â

 

Requires a server to host NetBoot service and the AXD install 
image

Â

 

Xserve must be on the same subnet as the NetBoot server

Install AXD EFI tools on an 
internal volume

Advantages:
Â

 

Allows you to use AXD EFI tools
Â

 

Don’t need physical access to Xserve to run AXD remotely
Disadvantages:
Â

 

Requires a volume on the Xserve that has 15 megabytes (MB) free 
and that doesn’t have Mac OS X or Mac OS X Server installed

Install AXD EFI tools on a 
portable storage device

Advantages:
Â

 

Allows you to use AXD EFI tools
Â

 

You can use the same portable storage device to test multiple 
Xserves

Disadvantages:
Â

 

Requires a volume on the Xserve that has 15 MB free and that 
doesn’t have Mac OS X or Mac OS X Server installed

Â

 

Portable storage device must be physically connected to the 
Xserve
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Requirements

 

Before you can run AXD, you must meet general, storage device, and local and remote 
requirements.

If you want to host AXD on a NetBoot server, additional requirements must be met by 
the NetBoot server.

 

General Requirements

 

To run AXD, you must have the following:
Â

 

An Intel-based Xserve with Mac OS X Server version 10.4.10 or later installed
Â

 

The Mac OS X Server Install discs and Administration Tools disc included with 
Mac OS X Server version 10.4.10 or later

 

Storage Device Requirements

 

Depending on whether you want to run AXD EFI tools, AXD Mac OS X tools, or both, 
you need empty volumes either on the Xserve or on a portable storage device.

If you want to run AXD Mac OS X tools, the storage device must use the GUID Partition 
Table partition scheme. If you’re running only AXD EFI tools on the storage device, you 
don’t need to use the GUID Partition Table partition scheme.

 

Install AXD Mac OS X tools on 
an internal volume

Advantages:
Â

 

Allows you to use AXD Mac OS X tools
Â

 

Don’t need physical access to Xserve to run AXD remotely (if you 
have Apple Remote Desktop)

Disadvantages:
Â

 

Requires an empty volume on the Xserve with 6 GB free
Â

 

Must install Mac OS X Server on the empty volume

Install AXD Mac OS X tools on 
a portable storage device

Advantages:
Â

 

Allows you to use AXD Mac OS X tools
Â

 

You can use the same portable storage device to test multiple 
Xserves

Disadvantages:
Â

 

Requires an empty volume on the portable storage device with 
6 GB free

Â

 

Must install Mac OS X Server on the empty volume
Â

 

Portable storage device must be physically connected to the 
Xserve

 

Option Considerations
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You can run both AXD tools by having two empty volumes on the same Xserve or 
portable storage device. You need at least one of the following:

 

Local and Remote Requirements

 

To run AXD on your local Xserve, you’ll need to attach a keyboard, mouse, and display.

To run AXD remotely, you must have the following:
Â

 

A Macintosh computer with Mac OS X version 10.4.4 or later installed. Mac OS X 
version 10.4.10 or later is recommended. This computer is referred to as the 

 

host 
computer

 

.
Â

 

A network connection or a direct Ethernet connection from the host computer to the 
Xserve. The Xserve is referred to as the 

 

client Xserve

 

.
Â

 

If the client Xserve is going to run AXD EFI tools and use a network connection, the 
network connection must use a built-in Ethernet port, and not an Ethernet adapter 
card.

Â

 

The Xserve must have AXD installed either on an internal volume or on a connected 
portable storage device; or it must be able to run AXD from a NetBoot server.

Â

 

The host computer must run AXD Mac OS X tools. The client Xserve can run AXD EFI 
tools or AXD Mac OS X tools.

Â

 

If the client Xserve is running AXD Mac OS X tools, you must be able to log in as the 

 

root

 

 account. The root account is a system administrator who has complete access to 
the Xserve.

If you want to run AXD entirely remotely (for situations where the Xserve is physically 
inaccessible or if you want to save AXD EFI tools test results), in addition to meeting the 
network requirements, the Xserve must be able to load Mac OS X Server.

 

NetBoot Server Requirements

 

To host a NetBoot server, your NetBoot server must:
Â

 

Have Mac OS X Server version 10.4.4 or later installed. Mac OS X version 10.4.10 or 
later is recommended.

Â

 

Be on the same subnet as the Xserve being tested.
Â

 

Have 15 MB of hard drive space available for an AXD NetBoot image.

 

Goal Requirement

 

Run AXD EFI tools A volume on the Xserve that has at least 15 MB free, but doesn’t 
have Mac OS X or Mac OS X Server installed

Run AXD Mac OS X tools An empty volume on the Xserve with at least 6 GB free

Test multiple Xserves and run 
AXD EFI tools

A USB drive or other portable storage device with a volume that 
has at least 15 MB free, but doesn’t have Mac OS X or Mac OS X 
Server installed

Test multiple Xserves and run 
AXD Mac OS X tools

A USB drive or other portable storage device that has an empty 
volume with at least 6 GB free
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Setup and Installation

 

Before you can run AXD, you must set up your testing 
environment and install AXD.

 

Make sure you meet AXD requirements before attempting setup and installation. For 
more information, see “Requirements” on page 6.

 

Setting Up a NetBoot Server

 

Before you set up a NetBoot server, make sure you have an available server that meets 
the requirements described in “NetBoot Server Requirements” on page 7.

After you set up a NetBoot server, you install the AXD NetBoot image. Because the AXD 
NetBoot image is a special image, you can’t use System Image Utility to delete the 
image.

For information about deleting the AXD NetBoot image, see the next section, “Deleting 
the AXD NetBoot Image.”

 

To set up a NetBoot server:
1

 

Open Server Admin (located in /Applications/Server).

 

2

 

If the server that will host NetBoot isn’t listed, click Add Server in the toolbar. Enter the 
IP address of the server in the Address field, enter the user name and password of the 
server administrator in the User Name and Password fields, and then click Connect.

 

3

 

Click the disclosure triangle for the server that will host NetBoot.

4 Select NetBoot, click Settings, and then click General.

5 In the network interface list, select the Enable checkboxes for the interfaces that you 
want to serve the AXD NetBoot images over.

If multiple network interfaces are listed, it’s likely that only one of the interfaces is on 
the same subnet as your Xserve. If you’re not sure which interface is on the same 
subnet, open Network Utility (located in /Applications/Utilities) on your NetBoot server 
and your Xserve. In the Info pane, choose different network interfaces on the NetBoot 
server and your Xserve and compare the IP Address fields. Usually, computers are on 
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the same subnet if their IP addresses start with same few numbers (for example, they 
both start with 192.168.2).

6 In the volume list, select the Images and Client Data checkboxes for the volume that 
will store the AXD NetBoot image.

The volume must have at least 15 MB free.

7 Click Save.

8 In the Finder, navigate to the AppleXserveDiagnostics folder in your Mac OS X Server 
Administration Tools disc, and then open AppleXserveDiagnosticsNetBoot.pkg.

9 Follow the onscreen instructions to install the AXD NetBoot package.

10 In Server Admin, select NetBoot, and then click Images.

11 If the AXD NetBoot image has the same index (listed in the Index column) as another 
image, deselect the Enable checkbox for the conflicting image.

12 Click the Start Service button in the toolbar.

Deleting the AXD NetBoot Image
You can’t use System Image Utility to delete the AXD NetBoot image. Instead, you must 
delete the AXD NetBoot image in the NetBoot image folder, which is located at:

/Volumes/volumename/Library/NetBoot/NetBootSP#

Replace volumename with the name of the volume that you’re installing the AXD 
NetBoot image onto. The number (#) varies depending on if you’re using several 
NetBoot volumes. If you’re using only one NetBoot volume, the AXD NetBoot image is 
located in NetBootSP0. If you’re using several NetBoot volumes, the AXD NetBoot 
image can be located in another folder (for example, NetBootSP1, NetBootSP4, or 
NetBootSP11).

To delete the AXD NetBoot image:
m Open the Finder and delete AXD.nbi from the NetBoot image folder.

Setting Up a Storage Device for AXD Tool Installation
To set up an internal volume or portable storage device for AXD tool installation, you 
must have at least 15 MB of available space for AXD EFI tools or at least 6 GB of storage 
capacity for AXD Mac OS X tools. These requirements are described in detail in “Storage 
Device Requirements” on page 6.

If you’re installing AXD Mac OS X tools on one of the volumes, the storage device 
should use the GUID Partition Table partition scheme. To view the storage device’s 
partition scheme, open Disk Utility, and select the storage device. Make sure you select 
the storage device and not a volume within the storage device. At the bottom of the 
Disk Utility window, Partition Scheme should say GUID Partition Table.
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Note:  Some portable storage devices aren’t fast enough to use as startup volumes. If 
you insert your portable storage device and a dialog appears asking you to eject a CD-
ROM, this signifies that your drive isn’t fast enough. If your drive isn’t fast enough to 
use as a startup volume, it can’t be used for AXD tools.

You can’t use these instructions on any storage devices that are currently in use. If you 
want to create empty volumes on the storage device that’s currently running Mac OS X 
Server, you’ll need to load Disk Utility from the Mac OS X installation disc or load Disk 
Utility while your Xserve is connected to another computer and is in target disk mode. 
Both of these methods erase the contents of your Xserve’s hard drive and require you 
to reinstall and reconfigure Mac OS X Server.

To create empty storage device volumes and correctly format them:
1 Open Disk Utility (located in /Applications/Utilities).

Make sure you open Disk Utility on a computer with Mac OS X or Mac OS X Server 
version 10.4.10 or later installed.

2 Select the storage device that you want to set up.

Make sure you select a storage device, and not volumes within the storage device. 
Volumes within a storage device are indented one level.

3 Click the Partition tab.

4 Review the partition sizes and adjust them to meet AXD tools storage requirements.

5 If you’re going to install AXD Mac OS X tools on a volume in the storage device, click 
Options, select GUID Partition Table, and click OK.

6 Click Partition.

WARNING:  The following instructions will erase all data on your storage device. Back 
up critical data before performing the following instructions.

To do this Do this

Display a partition’s size Click the partition and review the Size field.

Set the size of the partition Edit the Size field.

Prevent a partition from being 
automatically adjusted when 
you edit other partitions

Click the lock icon in the partition.

Create more partitions Click Split.

Delete partitions Click Delete.

Name a partition Select it and enter a name in the Name field. Because this name is 
used when selecting which volume to start up Mac OS X in, choose 
a name that identifies the volume as being used for AXD tools.
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Installing AXD EFI Tools
Before you install AXD EFI tools, make sure that your storage device has a volume that 
has at least 15 MB available, but doesn’t have Mac OS X or Mac OS X Server installed. 
For more information, see “Setting Up a Storage Device for AXD Tool Installation” on 
page 9.

To perform these instructions, you’ll need the Mac OS X Server Administration Tools 
disc included with Mac OS X Server version 10.4.10 or later. You can also download the 
latest Mac OS X Server Administration Tools disc image from www.apple.com/support/.

If you’re performing this task to install AXD EFI tools on an internal volume on the 
Xserve, you’ll need administrator access to the Xserve. If you’re performing this task to 
install AXD EFI tools on a portable storage device, you can use any computer that you 
have administrator access to.

If you want to connect a host computer directly to the Xserve, and the host computer 
doesn’t provide DHCP service on the port used to directly connect to the Xserve, you’ll 
need to create a file on the Xserve that assigns an IP address to the Xserve. However, if 
the host computer provides DHCP service, don’t make this file. For information about 
how to find out if a computer is providing DHCP service, see Network Services 
Administration, at:

www.apple.com/server/documentation

To install AXD EFI tools:
1 Insert the Mac OS X Server Administration Tools disc.

If you have a disc image of the Mac OS X Server Administration Tools disc, double-click 
the .dmg file to mount the disc image.

2 Open AppleXserveDiagnosticsEFI.pkg (located on the disc, at /AppleXserveDiagnostics).

3 Follow the onscreen instructions, and at the Select Destination step, choose a volume 
with at least 15 MB of space available, and that doesn’t have Mac OS X or Mac OS X 
Server installed.

4 If you’re prompted to authenticate, authenticate as a user with admin privileges.

5 If you want to connect a host computer directly to the Xserve and the host computer 
doesn’t provide DHCP service on the port used to directly connect to the Xserve, do 
the following:

a Open TextEdit (located in /Applications).
b In the body of a new file, enter an IP address that’s not in use by the host computer. 

For example, enter:
123.123.123.123

If TextEdit doesn’t open with a new blank file, choose File > New.

c Choose Format > Make Plain Text.

http://www.apple.com/support/
http://www.apple.com/server/documentation/
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d Choose File > Save As. 
e Name the file axd_set_ip_address, and then change the location of the file to the 

volume with AXD EFI tools installed.
f Select “If no extension is provided, use ‘.txt’,” and then click Save.

Installing AXD Mac OS X Tools
Before you install AXD Mac OS X tools, make sure that your storage device uses the 
GUID Partition Table partition scheme and that it has an empty volume with 6 GB of 
available space. For more information, see “Setting Up a Storage Device for AXD Tool 
Installation” on page 9.

To perform these instructions, you’ll need the Mac OS X Server Administration Tools 
disc included with Mac OS X Server version 10.4.10 or later. You can also download the 
latest Mac OS X Server Administration Tools disc image from www.apple.com/support/.

If you’re performing this task to install AXD Mac OS X tools on an internal volume on 
the Xserve, you’ll need admin access to the Xserve. If you’re performing this task to 
install AXD Mac OS X tools on a portable storage device, you can use any computer 
that you have admin access to.

Installing AXD Mac OS X tools involves three major steps:
Â Install Mac OS X Server with minimal options selected
Â Copy AXD Mac OS X tools from the Mac OS X Server Administration Tools disc to 

/Applications
Â Configure Mac OS X Server

By dedicating a minimal installation of Mac OS X Server for use with AXD Mac OS X 
tools, you reduce the risk of server processes interrupting AXD testing.

To install AXD Mac OS X tools:
1 Insert the Mac OS X Server Install disc.

2 Open the Install Mac OS X Server application, click Restart, and authenticate, if 
requested.

The computer restarts and loads the Mac OS X Server Installer.

3 Continue through the Installer until you reach the Select Destination step.

4 Select a volume that’s at least 6 GB. If the volume isn’t empty, click Options, select 
“Erase and Install,” and then click OK. Click Continue.

5 In Installation Type, click Customize, deselect all checkboxes, and then click Install.

If the volume is very close to 6 GB in size, the Installer might automatically load the 
Customize list.

http://www.apple.com/support/
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When the Installer finishes installing Mac OS X Server, it restarts the computer and 
Server Assistant opens.

6 Enter information in Server Assistant as requested. Don’t enable any services.

When you finish entering information in Server Assistant, Mac OS X Server loads.

7 Log in with the user name “root” and with the password of the user you created in 
Server Assistant.

You must set up and run AXD Mac OS X tools as root. Otherwise, you won’t be able to 
test the Xserve you’ve installed AXD Mac OS X tools on.

8 Insert the Mac OS X Server Administration Tools disc.

If you have a disc image of the Mac OS X Server Administration Tools disc, double-click 
the .dmg file to mount the disc image.

9 Open the Finder and drag the AXD.app file from /AppleXserveDiagnostics on the 
Mac OS X Server Administration Tools disc to your /Applications folder.

10 If you’re setting up a client Xserve, open the Finder, select your /Applications folder, 
click the Gear button, and choose New Folder. Name the folder AXDClient.

Client Xserves are remotely controlled by host computers.

11 Open System Preferences (located in /Applications). Change the following options in 
System Preferences panes:

If you can’t change settings in System Preferences, click the lock button and 
authenticate.

After installing the AXD Mac OS X tools, you must log in as root to run AXD tools to test 
your own Xserve. If you don’t log in as root, AXD Mac OS X tools enters host mode and 
waits for a connection to a client Xserve to control.

System Preferences pane Recommended configuration

Accounts Select the root account, and click Login Items. Click Add (+), select 
/Applications/AXD.app, and click Add.

CDs & DVDs In all pop-up menus, choose Ignore.

Dashboard & Exposé In all pop-up menus, choose “–.”

Desktop & Screen Saver In the Screen Saver pane, drag the “Start screen saver” slider to 
Never.

Energy Saver In the Sleep pane, drag both sliders to Never, and deselect “Put 
hard disk(s) to sleep when possible.”

Software Update In the Update Software Pane, deselect “Check for updates.”



3

14   

3 Loading AXD Tools

Before you load AXD tools, make sure you’ve properly 
installed and configured the tools. For more information, see 
Chapter 2, “Setup and Installation,” on page 8.

If you want to remotely test a client Xserve, you’ll need to first load AXD tools on the 
host computer, and then load the AXD tools on the client Xserve.

To load AXD tools, set the startup volume of the Xserve to the volume or disk image 
containing the AXD tools. If Mac OS X Server loads on your Xserve, you can change the 
startup disk in Startup Disk System Preferences. Otherwise, you can temporarily change 
the startup disk by pressing and holding one of several keys when starting up the 
Xserve:

Startup Disk System Preferences can load only AXD Mac OS X tools. Pressing the Option 
key at startup can load AXD EFI tools and AXD Mac OS X tools.

The Xserve becomes unavailable whenever you use AXD. Before starting tests, alert 
your users that the server will be unavailable.

Changing the Startup Disk in System Preferences
If your Xserve can load Mac OS X Server, you can use System Preferences to change the 
startup disk. The list of startup volumes includes internal volumes and connected 
portable storage device volumes.

Goal Press and hold this key at Xserve startup

Choose the AXD tools volume before 
loading Mac OS X

Option

Load the AXD EFI tools located on the 
Mac OS X Server Administration Tools disc

D (make sure the Mac OS X Server Administration Tools 
disc is inserted)

Load the AXD EFI tools disk image from a 
NetBoot server

F1 or a specific combination of the Xserve’s front panel 
buttons



Chapter 3    Loading AXD Tools 15

 

When you change the startup disk in System Preferences, you can’t select a startup disk 
with AXD EFI tools installed. To change the startup disk to the volume with AXD EFI 
tools installed, change the startup disk at startup. For more information, see “Changing 
the Startup Disk Temporarily at Startup” on page 16.

To change the startup disk in System Preferences:
1 Open System Preferences on the Xserve, and then select Startup Disk.

2 If the lock icon is locked, click it, and then authenticate as a system administrator.

3 Select the startup disk with the AXD tools and click Restart.

After you’re done using AXD tools, change the startup disk back to the volume you 
were previously using.

Changing the Startup Disk Using the Command-Line 
Interface
If your Xserve can load Mac OS X Server, you can use the command-line interface to 
change its startup disk. You can use the command-line to start up from internal 
volumes and connected portable storage device volumes.

You can also change the startup disk of a remote server using the command-line 
interface. Remote login must be enabled on the remote server (enabled by default). 
You can enable remote login in the Sharing pane of System Preferences.

When you change the startup disk using the command-line interface, you can’t select a 
startup disk with AXD EFI tools installed. To change the startup disk to the volume with 
AXD EFI tools installed, change the startup disk at startup. For more information, see 
“Changing the Startup Disk Temporarily at Startup” on page 16.

You’ll need to be able authenticate as the root account to change the startup disk in 
the command-line interface.

Note:  The Terminal commands described in this task are case-sensitive and must be 
entered as described.

To change the startup disk using the command-line interface:
1 Open Terminal (located in /Applications/Utilities).

2 If you want to connect to a remote server, enter the following in the Terminal window, 
and authenticate when requested:

ssh username@serveraddress

Replace username with the short name of a user who can authenticate as the root 
account on the server. Replace serveraddress with the URL, IP address, or host name of 
the server.

3 Enter the following, and authenticate as the root account when requested:



16 Chapter 3    Loading AXD Tools 

 

sudo bless -folder “/Volumes/volumename/System/Library/CoreServices” -

setBoot

Replace volumename with the name of the volume you want to start up from.

When you’re done using AXD tools, change the startup disk back to the volume you 
were using previously.

Changing the Startup Disk Using Apple Remote Desktop
If you have Apple Remote Desktop, you can change the startup disk of remote 
computers to an internal volume or connected portable storage device volume.

For information about using Apple Remote Desktop to set a computer’s startup disk, 
see Apple Remote Desktop Administrator’s Guide, located at:

www.apple.com/server/documentation

Changing the Startup Disk Temporarily at Startup
If your Xserve has issues loading Mac OS X Server or doesn’t have Mac OS X Server 
installed, you can temporarily change the startup disk by pressing and holding a key 
while the Xserve is starting up. This method requires that you have a keyboard and 
mouse attached to the Xserve and that you can restart the Xserve.

If you don’t have a keyboard and mouse attached to the Xserve, use the instructions in 
the next section, “Loading an AXD EFI Tools NetBoot Image Using the Xserve’s Front 
Panel.”

If a firmware password is set, you can’t temporarily change the startup disk by pressing 
and holding the D or F1 keys. You can temporarily change the startup disk by pressing 
and holding the Option key but you must authenticate with the firmware password.

For information about disabling the firmware password, see “Disabling the Firmware 
Password” on page 19.

To temporarily change the startup disk at startup:
1 Restart the Xserve.

2 While the Xserve is restarting, press and hold the Option key until a list of volumes 
appears. If you’re asked to authenticate, enter the firmware password and click the 
Continue (right-arrow) button.

If you have the Mac OS X Server Administration Tools disc inserted, you can start up 
using AXD EFI tools located on the disc by pressing and holding the D key instead of 
the Option key.

If you want to load an AXD tools NetBoot image hosted on a NetBoot server, press and 
hold the F1 key instead of the Option key.

http://www.apple.com/server/documentation/
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Both of these alternatives immediately load AXD EFI tools and bypass the list of 
volumes described in the next step.

3 If you loaded the list of volumes instead of immediately loading AXD tools, select the 
volume with AXD tools, and then click the arrow button to load it.

The AXD EFI tools volume is listed as AXD EFI 3X102.

After you’re done using AXD EFI tools, when you restart the Xserve, it starts up using its 
original startup volume.

Loading an AXD EFI Tools NetBoot Image Using the Xserve’s 
Front Panel
You can use the Xserve’s front panel buttons to load an AXD EFI tools disk image 
hosted by a NetBoot server. This technique is useful for situations where your Xserve:
Â Doesn’t have a monitor or keyboard attached
Â Doesn’t respond to keyboard input
Â Doesn’t have Mac OS X Server installed

The Xserve must be on the same subnet as the NetBoot server hosting the AXD EFI 
tools disk image.

If the Xserve’s EFI requires a password, you won’t be able to load a NetBoot image 
using the front panel. You’ll need to disable the firmware password before you can use 
the front panel. To disable the password, you must be able to load Mac OS X Server on 
the Xserve.

To use the Xserve’s front panel to load an AXD EFI tools NetBoot image:
1 Turn off the Xserve.

2 Press and hold the system identifier button and press the on/standby button.

3 Continue holding the system identifier button until the top row of lights move right to 
left. Release the system identifier button.

System identifier
button

On/standby
button

Top row of lights blink right to left,
then left to right.
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If the two rows of lights on the front panel blink once and the Xserve resumes its 
startup sequence, an firmware password is enabled. You’ll need to disable the 
password.

For information about disabling the firmware password, see the next section, 
“Disabling the Firmware Password.”

4 When you release the system identifier button, the rightmost light in the bottom row 
should turn on.

5 Press the system identifier button again. The lights in the bottom row should now be 
moving right to left.

6 Press the button repeatedly until the leftmost light in the bottom row turns on.

7 When the leftmost light is on, press and hold the system identifier button until all the 
lights in the top row are on. Release the system identifier button.

When you release the button, the Xserve loads the AXD EFI tools NetBoot disk image.

After you’ve run AXD EFI tools, the Xserve starts up using its original startup volume 
when you restart.

Both rows of lights blink once.
Disable the firmware password.

Bottom, rightmost light comes on.

Bottom row of lights blink right to left.

Bottom, leftmost light comes on.

Top row of lights come on.
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Disabling the Firmware Password
If a firmware password is enabled, you can’t:
Â Load an AXD EFI tools NetBoot image using the Xserve’s front panel
Â Temporarily change the startup volume by pressing and holding F1 or D at startup

If a firmware password is enabled and you try to temporarily change the startup 
volume by pressing and holding Option at startup, you must authenticate.

To disable the firmware password:
1 Insert the Mac OS X Server Install disc.

2 Open Firmware Password Utility application (located in the Mac OS X Server Install disc 
in /Applications/Utilities).

3 In Firmware Password Utility, click Change.

4 Deselect “Require password to change firmware settings,” and click OK. Authenticate 
when asked.

5 Close Firmware Password Utility.
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4 Using AXD Tools

Before you can use AXD tools, make sure you’ve properly 
loaded the tools. For more information, see Chapter 3, 
“Loading AXD Tools,” on page 14.

AXD Mac OS X tools and AXD EFI tools have different interfaces and functionality. This 
chapter describes how to use both AXD tools.

Setting AXD to Host, Client, or Local Mode
When AXD tools starts, AXD tools can enter one of three modes depending on 
whether:
Â You’re opening AXD EFI tools or AXD Mac OS X tools
Â Any of the computers on the same subnet are host computers
Â A host computer is directly connected
Â You’re logged in as root
Â You’re running AXD Mac OS X tools on a computer that isn’t an Intel-based Xserve

The following table describes the three modes:

Mode Description Automatically enters mode if

Host The computer searches for Xserves 
that are on the same subnet and start 
AXD tools in remote mode. When one 
is found, the host computer controls 
the client Xserve’s AXD tools.

You run AXD Mac OS X tools and 
either:
Â The computer isn’t an Intel-based 

Xserve.
Â You’re not logged in as root.

Client The Xserve can be controlled by a 
host computer.

You’re running AXD EFI tools and a 
host computer is on the same subnet 
or is directly connected.

Local The Xserve runs all tests locally. You’re running AXD EFI tools and a 
host computer isn’t on the same 
subnet and isn’t directly connected.
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If you’re logged in as root on an Intel-based Xserve, and then you run AXD Mac OS X 
tools, you can choose which mode to enter.

Remotely Testing a Client Xserve
If you want to test a client Xserve, you must first load AXD tools on the host computer, 
set it to connect to a client Xserve, and then load the AXD tools on the client Xserve 
and set it to be a client of a remote host.

The host computer must run AXD Mac OS X tools. The client Xserve can run AXD EFI 
tools or AXD Mac OS X tools. The available tests are based on which AXD tools the 
client Xserve is running.

When you load AXD EFI tools, the Xserve first looks for a host computer. If it finds a 
host computer, the Xserve enters client mode. If it doesn’t find a host computer, the 
Xserve enters local mode.

When you load AXD Mac OS X tools, the Xserve automatically becomes a host 
computer if either of the following are true:
Â You logged in to Mac OS X with an account that isn’t root.
Â You are running AXD Mac OS X tools on a computer that isn’t an Intel-based Xserve.

If AXD Mac OS X tools doesn’t automatically become a host computer, it asks if it 
should connect to a client Xserve, be a client of a remote host, or run tests locally.

To remotely test a client Xserve:
1 On the host computer, open AXD Mac OS X tools (located in /Applications).

2 If the host computer is an Intel-based Xserve and you’re logged in as root, when AXD 
opens, a dialog asks you to choose which mode to enter. Choose “Connect to remote 
Xserve” and click OK.

If your computer isn’t an Intel-based Xserve, the dialog doesn’t appear, and AXD 
automatically enters host mode.

3 On the client Xserve, change the startup disk to a volume with AXD tools and restart it.

You can also temporarily change the startup disk to either a volume with AXD tools on 
it or to an AXD tools NetBoot disk image when you start up the Xserve.

For more information about how to change or temporarily change the startup volume, 
see Chapter 3, “Loading AXD Tools,” on page 14.

4 If you’re loading AXD Mac OS X tools, log in as root, and if AXD doesn’t open 
automatically, open AXD (located in /Applications). Choose “Client of a remote host,” 
and click OK.

5 If you’re loading AXD EFI tools, the Xserve automatically enters client mode.
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There are several ways to determine whether the host computer and client Xserve have 
established a successful connection:
Â The IP address field in the AXD window on the host computer should match the IP 

address assigned to the client Xserve.
Â The name of the AXD window on the host computer is “AXD remote log,” not “AXD 

local log.”
Â The log area of the client Xserve uses more of the AXD window. The Shut Down, 

Restart, and a few other buttons are removed.

Testing the Local Xserve Using AXD EFI Tools
To test the local Xserve, make sure none of the computers on the same subnet as the 
Xserve have loaded AXD Mac OS X tools in host mode. If a computer on the same 
subnet loaded AXD Mac OS X tools in host mode, the Xserve automatically enters client 
mode.

To test the local Xserve using AXD EFI tools:
m Restart the Xserve and press and hold a key, or use the Xserve’s front panel buttons to 

load the volume or NetBoot disk image with AXD EFI tools.

For more information about how to temporarily change the startup volume while 
starting the computer, see Chapter 3, “Loading AXD Tools,” on page 14.

When the AXD EFI tools loads and doesn’t find a host computer, it enters local mode.

Testing the Local Xserve Using AXD Mac OS X Tools
To test the local Xserve, you must log in as root. If you don’t log in as root, AXD 
Mac OS X tools automatically enters host mode.

To test the local Xserve using AXD Mac OS X tools:
1 Change the startup disk of the Xserve to a volume with AXD Mac OS X tools, restart it, 

and log in as root.

2 If AXD Mac OS X tools doesn’t open automatically, open it (located in /Applications).

3 When AXD opens, choose “Local” from the dialog that appears and click OK.

Using AXD EFI Tools
For information about AXD EFI tools, see the following topics:
Â “Customizing AXD EFI Test Settings” on page 23
Â “Clearing the Test Log” on page 23
Â “Viewing the Hardware Profile” on page 23
Â “Shutting Down or Restarting the Xserve” on page 24
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Customizing AXD EFI Test Settings
You can customize AXD test settings in several ways by choosing which tests are run, 
whether to loop tests, and whether to stop or continue testing when an error occurs.

To customize AXD EFI tools test settings:
1 In AXD EFI tools, select the test settings you want.

2 To run the test, click Test.

Clearing the Test Log
The test log contains all test messages that have occurred during the current AXD 
session. If you quit AXD, the log is cleared.

To clear the test log without quitting AXD, click Clear Test Data.

Viewing the Hardware Profile
The hardware profile lists all hardware components in the Xserve.

You can view the hardware profile by choosing Hardware Profile > Display Hardware 
Profile.

To do this Do this

Choose which tests are run In the Test Selections pane, do the following:
Â To select a test, select the checkbox next to the test.
Â To select a specific test within a category of tests, click the 

disclosure triangle next to the category, and then select 
individual tests.

Â To select all tests, click Select All.
Â To remove all tests, click Deselect All.

Loop all selected tests In the Controls pane, do the following:
Â To loop all selected tests a specific number of times, select “Loop 

# times” and replace # with the number of times to loop.
Â To run all tests once, select “Loop # times” and replace # with the 

number 1.
Â To loop all tests for a specific amount of time, select “Loop for # 

hours and # minutes” and replace # with number of hours and 
minutes to loop. When the specified time is reached, the current 
loop must complete before the tests stop. For example, if one 
loop of your test set takes 2 hours to complete, and your 
specified time is 3 hours, AXD stops testing in 4 hours. (Instead of 
stopping at 3, it waits for the current test set loop to complete 
before stopping.)

Change what to do when an 
error occurs

In the Controls pane, do the following:
Â To stop testing when the first error occurs, select Stop On Error.
Â To continue testing when errors occur, choose Continue On Error.
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Shutting Down or Restarting the Xserve
You can shut down or restart the Xserve in AXD EFI tools.

To shut down or restart the Xserve, click Shut Down or Restart.

Using AXD Mac OS X Tools
For information about using AXD Mac OS X Tools, see the following topics:
Â “Customizing AXD Mac OS X Test Settings” on page 24
Â “Working With Test Groups” on page 25
Â “Viewing Logs” on page 26
Â “Shutting Down or Restarting the Xserve” on page 28
Â “Quitting AXD Mac OS X Tools While a Test is Running” on page 28

Customizing AXD Mac OS X Test Settings
You can customize AXD test settings in several ways by choosing which tests are run, 
whether to loop tests, and whether to stop or continue testing when an error occurs.

To customize AXD Mac OS X tools test settings:
1 In AXD Mac OS X tools, select the test settings you want.

2 To save your customized test settings for future use, in the Test Group pop-up menu, 
choose Save Current Group. Enter a name for the group and click OK.

To do this Do this

Choose which tests are run In the Test Selections list, do the following:
Â To select a test, select the checkbox next to the test.
Â To select a specific test within a category of tests, click the 

disclosure triangle next to the category, and then select 
individual tests.

Â To select all tests, click the Select All (+) button.
Â To remove all tests, click the Deselect All (–) button.

Loop all selected tests Select “Loop tests by,” and then do the following:
Â To loop all selected tests a specific number of times, select Count 

and enter a number of times to loop.
Â To loop all selected tests for a specific amount of time, select 

Time and enter the number of hours and minutes to loop. When 
the specified time is reached, the current loop must complete 
before the tests stop. For example, if one loop of your test set 
takes 2 hours to complete and your specified time is 3 hours, AXD 
stops testing in 4 hours. (Instead of stopping at 3, it waits for the 
current test set loop to complete before stopping.)

Change what to do when an 
error occurs

In the On Error pop-up menu, do the following:
Â To stop testing when the first error occurs, choose Stop.
Â To continue testing when errors occur, choose Continue.
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For more information, see the next section, “Working With Test Groups.”

3 To run the test, click Start Testing.

Working With Test Groups
You can create test groups based on your customized test settings. These are similar to 
templates because they allow you to reuse your test settings without having to change 
each setting individually. After choosing a test group, you can still change its settings.

There are two sets of test groups, which change based on the type of AXD tools run by 
the Xserve. If you’re testing a client Xserve that’s running AXD EFI tools, the test groups 
are different than if you’re testing an Xserve running AXD Mac OS X tools.

When you create or delete a test group, that test group is created or deleted in the set 
of test groups you’re currently using. For example, if you create a test group for Xserves 
running AXD Mac OS X tools, it doesn’t become available for Xserves running AXD EFI 
tools.

There are several test groups included with AXD. These test groups stop when an error 
occurs and aren’t looped.

You can also export a test group to a file. By exporting a test group, you can use that 
file to re-create that test group on other AXD installations. For example, if you install 
AXD Mac OS X tools on several Xserves, you can copy the test group file to each of 
those Xserves, making identical tests available without having to manually create a 
new test group.

To work with test groups:
m In AXD Mac OS X tools, choose the options you want.

Tool used Test group Test selections

AXD Mac OS X tools Default All memory, USB port, fan, hard drive, sensor, and 
power supply tests. Ethernet MAC Address verification 
and ROM checksum verification.

AXD Mac OS X tools Quick Test All sensor tests.

AXD EFI tools Default All memory, boot ROM, processor, fan, video controller, 
sensor, Ethernet controller, hard drive, and power 
supply tests.

AXD EFI tools Quick Test Extended memory test P007 and all sensor.

To do this Do this

Use a test group In the Test Group pop-up menu, choose a test group.

Create a new test group In the Test Group pop-up menu, choose Save Current Group. Enter 
a name for the group and click OK.

Delete a test group In the Test Group pop-up menu, choose a test group. Choose Edit > 
Delete Test Group.
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Viewing Logs
You can view the following types of logs in AXD Mac OS X tools:

You can also view logs stored on other volumes. This can help you diagnose issues that 
you run into while you’re not using AXD.

When you view logs in AXD Mac OS X tools, AXD shows you whether it’s able to load 
the log with a colored circle next to the log name.

To view logs:
1 Open AXD Mac OS X tools.

2 If tests are currently running, wait for them to complete or stop them.

If tests are running, you can view only the test log.

3 Do any the following:

Export a test group Choose File > Export Test Group, choose a location, name the test 
group, and click Save.

Import a test group Choose File > Open, select an .axdconfig file, and click Open.

To do this Do this

Log type Description

Test All messages from tests run in the current AXD Mac OS X tools 
session

Hardware Info Listing and description of all installed hardware

System All of the logs that are also available in System Profiler (located in 
/Applications/Utilities)

Color Status

No circle You haven’t loaded the log during this AXD session, or the log 
hasn’t been created yet.

Yellow The log didn’t load. This usually occurs when there isn’t any data in 
the log.

Green The log loaded.

To do this Do this

Choose a different volume to 
view logs on

Choose Logs > View Different System’s Logs, choose a volume from 
the “Volume to gather system logs from” pop-up menu, and click 
OK.

View logs in the current or 
chosen volume

Choose a log from the “View log” pop-up menu.

Search for specific text within 
the log

Enter text in the search field. When you press Return, matching text 
is highlighted in the log area.
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Setting Log Preferences
You can set up log preferences so that the AXD test logs are automatically saved to a 
file at a location you choose. AXD test logs are created every time you start a new AXD 
session.

When AXD Mac OS X tools saves a log, it overwrites any existing log of the same name. 
Log preferences can automatically customize the name of the log file so that the log 
files aren’t overwritten.

If you don’t use any of the naming options, the log is saved as:

AXD_mode_autosave_log.txt

If you are testing locally, mode is replaced by “local.” If you are testing remotely, mode is 
replaced by “remote.”

If you use all of the naming options, the log is saved as:

AXD_mode_autosave_log_date_ethernetaddress uniquename.txt

The appended values use this format:

The unique name will be appended only if a file of the same name exists.

A log for the local Xserve with all naming options enabled (using the example values) is 
saved as:

AXD_local_autosave_log_19_Jun_2007_01_23_45_67_89_ab - 1.txt

To set log preferences:
1 In AXD Mac OS X tools, choose AXD > Preferences.

2 To automatically save test logs, select “Auto-save test log.”

If you don’t select this option, you can’t perform the steps that follow.

3 To choose the location of the automatically saved log, click “Choose auto-save location,” 
select a location, and then click Open.

Clear logs Choose Logs > Clear current Log or choose Logs > Clear All Logs.
The name of the currently viewed log replaces current.

Refresh logs Choose Logs > Refresh Current Log or choose Logs > Refresh All 
Information Logs.

To do this Do this

Value Format Example

date DD_Mon_Year 15_Jul_2007

ethernetaddress ##_##_##_##_##_## 01_23_45_67_89_ab

uniquename - # - 1
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4 Configure the test log naming options.

Shutting Down or Restarting the Xserve
If you’re running AXD Mac OS X tools on the local Xserve, or on a host computer, you 
can shut down or restart the Xserve. However, if the Xserve is in client mode, you can’t 
shut down or restart the Xserve locally.

To shut down or restart the Xserve, click Shut Down or Restart.

Quitting AXD Mac OS X Tools While a Test is Running
If you try to quit AXD Mac OS X tools while a test is running, you won’t be able to print 
or save any logs from the current AXD session. Make sure you print or save any critical 
logs before quitting.

Instead of quitting in the middle of a test, you can stop the current test, print or save 
logs, and then quit.

To do this Do this

Ensure newly created log files 
don’t overwrite old log files

Select “Use unique name.”

Append the Ethernet address of 
the Xserve that’s being tested

Select “Append Ethernet Address.”

Append the run time and date 
of the session’s first tests

Select “Append time and date.”
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AXD Tools Test Reference

This reference describes all the tests available in AXD and 
provides estimates for how long the tests take to complete.

The types of tests available depend on if you’re using AXD EFI tools or AXD Mac OS X 
tools.

Comparison of Available Tests
The following table compares the tests available by component, depending on if you’re 
using AXD EFI tools or AXD Mac OS X tools. For more information about the specific 
tests available for each component, see “AXD EFI Tools Tests” on page 30 and “AXD 
Mac OS X Tests” on page 35.

A % signifies that a test is available, while a blank entry signifies that there are no 
available tests:

Component tested
Available in AXD 
EFI tools

Available in AXD 
Mac OS X tools Notes

Boot ROM %

Ethernet controller % % Different tests are available depending 
on the tool.

Fan % % Different tests are available depending 
on the tool.

Hard drive % % Different tests are available depending 
on the tool.

Memory (simple) % Tests only the first 2.5 GB of memory.

Memory (multicore) % % Tests the first 2.5 GB of memory but 
using all available CPU cores.

Memory (extended) % Tests all memory.

Memory (SMBIOS) % % Tests if memory has been mapped out 
correctly.
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AXD EFI Tools Tests
These tests are available if your Xserve is running AXD EFI tools.

Boot ROM Tests

Ethernet Controller Tests

Fan Tests

Memory (ECC) % Tests for memory ECC errors. This test 
clears the error count, so it should be 
run first (before running any other 
memory tests).

Power supply % %

Sensor % % AXD Mac OS X tools has an additional 
sensor test.

USB port % %

Video controller % % AXD Mac OS X tools have more tests 
than AXD EFI tools.

Component tested
Available in AXD 
EFI tools

Available in AXD 
Mac OS X tools Notes

Test Estimated completion time Description

Boot ROM Checksum 1 second Verifies the Boot ROM checksum

Boot ROM FW GUID MAC 
Addr Checksum

1 second Verifies the Boot ROM FireWire GUID 
MAC address checksum

Test Estimated completion time Description

MAC Address Verification 1 second Verifies MAC address isn’t all FFs or 
00s

PCI-E 4 LinkWidth Verification 1 second Verifies PCI link width is 4

Test Estimated completion time Description

Quick Motor 1 second Verifies that the fan motor can be 
turned on. Reads the set point of the 
motor and verifies that the motor is 
spinning within 20% of the set speed.
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Hard Drive Tests

Memory (Simple) Tests
Simple memory tests test the first 2.5 GB of memory. To test all memory, run extended 
memory tests.

Even though simple memory tests don’t test all memory, run these tests to detect 
intermittent memory issues.

In AXD EFI tools, all memory tests (simple, multicore, extended, and SMBIOS) are 
grouped under Memory tests.

Note:  The time required to complete memory tests correlates to the size of memory 
being tested. These estimates are based on testing 1 GB of memory.

Long Motor 15 seconds Verifies that the fan motor can reach 
speeds of within 10% of its high and 
low limits in 15 seconds. While the test 
is running, all fans that aren’t being 
tested are left under system control.

Long Motor Fans Full 15 seconds Verifies that the fan motor can reach 
speeds of within 10% of its high and 
low limits in 15 seconds. While the test 
is running, all fans that aren’t being 
tested are set to their maximum 
speed. After the test completes, the 
system regains control of the fan 
speed.

Test Estimated completion time Description

Test Estimated completion time Description

Full Read 30 minutes for an 80 GB 
drive; 4 hours for a 750 GB 
drive

Performs a DMA full-read scan at 1250 
RPM. This checks the entire hard drive 
for slow-read failures.

Test Estimated completion time Description

Address as Data 5 seconds Tests memory using the memory 
address as data

Patterns 25 seconds Tests memory using different data 
patterns

Marching Ones and Zeros 15 seconds Tests memory by walking 1s and 0s 
up and down memory

Knaizuk Hartmann 10 seconds Tests memory using this algorithm

MOD3 30 seconds Tests memory using this algorithm

Van de Goor’s March U 2 minutes Tests memory using this algorithm

Random Values 15 seconds Uses pseudo-random values
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Memory (Multicore) Tests
Multicore memory tests test the first 2.5 GB of memory using all available CPU cores.

In AXD EFI tools, all memory tests (simple, multicore, extended, and SMBIOS) are 
grouped under Memory tests.

Note:  The time required to complete memory tests correlates to the size of memory 
being tested. These estimates are based on testing 1 GB of memory.

Memory (Extended) Tests
Extended memory tests test all available memory.

Block Checkerboard 32 10 seconds Alternates 32-bit words with all 1s and 
all 0s, and then with all 0s and all 1s

Bit Checkerboard 32 10 seconds Alternates bits with all 1s and all 0s, 
and then with all 0s and all 1s

Sequential Byte Block 32 14 minutes Fills all bytes sequentially with 
patterns starting at 0x00 and ending 
at 0xFF

Walking One 32 5 minutes Walks 1s up and down memory

Walking Zero 32 5 minutes Walks 0s up and down memory

Walking Spread Bit 32 5 minutes Walks 0b01 up and then walks 0b10 
down memory

Walking Bit Flip 32 5 minutes Alternates words with walking 1 and 
walking 0, and then alternates with 
walking 0 and walking 1

Test Estimated completion time Description

Test Estimated completion time Description

MP Block Checkerboard 32 5 seconds Alternates 32-bit words with all 1s and 
all 0s, and then with all 0s and all 1s

MP Bit Checkerboard 32 5 seconds Alternates bits with all 1s and all 0s, 
and then with all 0s and all 1s

MP Sequential Byte Block 32 8 minutes Fills all bytes sequentially with 
patterns starting at 0x00 and ending 
at 0xFF

MP Walking One 32 2 minutes Walks 1s up and down memory

MP Walking Zero 32 2 minutes Walks 0s up and down memory

MP Walking Spread Bit 32 2 minutes Walks 0b01 up and then walks 0b10 
down memory

MP Walking Bit Flip 32 2 minutes Alternates words with walking 1 and 
walking 0, and then alternates words 
with walking 0 and walking 1
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In AXD EFI tools, all memory tests (simple, multicore, extended, and SMBIOS) are 
grouped under Memory tests.

Note:  The time required to complete memory tests correlates to the size of memory 
being tested. These estimates are based on testing 1 GB of memory

Memory (SMBIOS) Tests
SMBIOS tests check to see if bad memory was detected and mapped out at Xserve 
startup. When the Xserve tests memory at start up, it automatically maps out bad 
memory. Mac OS X doesn’t see this mapped out memory, so the non-SMBIOS memory 
tests don’t test it. The SMBIOS test reports these mapped out DIMMS.

In AXD EFI tools, all memory tests (simple, multicore, extended, and SMBIOS) are 
grouped under Memory tests.

Because memory is mapped only once, you should run this test once and not loop it.

Test Estimated completion time Description

Extended Memory Test P00F 5 seconds Tests memory using pattern 0. This 
fails if an error occurs.

Extended Memory Test P01F 5 seconds Tests memory using pattern 1. This 
fails if an error occurs.

Extended Memory Test P02F 5 seconds Tests memory using pattern 2. This 
fails if an error occurs.

Extended Memory Test P03F 5 seconds Tests memory using pattern 3. This 
fails if an error occurs.

Extended Memory Test P04F 5 seconds Tests memory using pattern 4. This 
fails if an error occurs.

Extended Memory Test P05F 5 seconds Tests memory using pattern 5. This 
fails if an error occurs.

Extended Memory Test P06F 5 seconds Tests memory using pattern 6. This 
fails if an error occurs.

Extended Memory Test P07F 5 seconds Tests memory using pattern 7. This 
fails if an error occurs.

Test Estimated completion time Description

SMBIOS Self-Test 1 second Checks the SMBIOS tables for 32-bit 
errors (type 18) and 64-bit errors (type 
33). Also verifies that the mapped-in 
DIMM size is appropriate for the slot 
it’s inserted into. If there’s a size 
mismatch, an error occurs.
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Power Supply Tests

Processor Tests

Sensor Tests

USB Tests
Connect USB devices before running USB tests.

Video Controller Tests

Test Estimated completion time Description

Good Bit 1 second Checks if the power supply’s good bit 
is set. If it’s not set, this could indicate 
that the power supply isn’t seated 
well, is bad, or that there’s no AC 
connected.

Quick 5 seconds This is available only if you have more 
than one power supply. This turns off 
the redundant power supplies so that 
only one power supply is used.

Test Estimated completion time Description

L1 Cache Test 1 second Verifies that the L1 cache is good on 
all processor cores

Test Estimated completion time Description

Sensor Reads 1 second Verifies that the sensor reads are 
within the preset sensor limits

Test Estimated completion time Description

Presence 1 second Verifies that a USB device is connected

Test Estimated completion time Description

PCI-E 8 LinkWidth Verification 1 second Verifies PCI link width is 8

Framebuffer Address as Data 2 minutes Tests the framebuffer using 
framebuffer addresses as data
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AXD Mac OS X Tests
These tests are available if your Xserve is running AXD Mac OS X tools.

Ethernet Controller Tests
Data loop tests can add to network traffic. Consider disconnecting from the network 
before running the data loop tests.

Hard Drive Tests

Memory (Simple) Tests
Simple memory tests test the first 2.5 GB of memory. All multicore memory tests listed 
in AXD EFI tools are run.

Even though simple memory tests don’t test all memory, run these tests to detect 
intermittent memory issues.

Note:  The time required to complete memory tests correlates to the size of memory 
being tested. These estimates are based on testing 1 GB of memory.

Test Estimated completion time Description

MAC Address Verification 1 second Verifies MAC address is not all FFs or 
00s

Ethernet ROM Checksum 1 second Verifies Ethernet ROM checksum is 
valid

MAC Data Loop 1 minute Verifies that there’s no data mismatch 
between sent and received data while 
looping within the MAC (a sublayer of 
the datalink layer in the ISO network 
reference model)

PHY Data Loop 1 minute Verifies that there’s no data mismatch 
between sent and received data while 
looping within the physical transport 
medium (PHY)

Test Estimated completion time Description

Threaded Surface Scan 30 minutes for an 80 GB 
drive; 4 hours for a 750 GB 
drive

Scans the entire surface of a hard 
drive

Test Estimated completion time Description

Simple Test 12 minutes Runs all multicore memory tests listed 
in AXD EFI tools
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Memory (SMBIOS) Tests
SMBIOS tests check to see if memory has been mapped out correctly. When the Xserve 
tests memory at startup, it automatically maps out bad memory. Mac OS X doesn’t see 
this mapped out memory, so the non-SMBIOS memory tests don’t test it. The SMBIOS 
test reports these mapped out DIMMS.

Because memory is mapped only once, you should run this test once and not loop it.

Memory (ECC) Tests
When an ECC error occurs, memory catches the problem and and fixes it. When you run 
other memory tests, the tests don’t realize an error has occurred. The ECC tests detect 
these memory fixes and report them. After you run ECC tests, the results are reset, so 
running the ECC tests again might result in success even though the previous test 
resulted in failure.

The ECC memory test should be run before running any other memory tests, catching 
any ECC errors generated by the system memory tests that were run at startup. After 
you run other memory tests, you should also run the ECC tests once more to see if the 
memory tests have trigged any ECC errors.

Fan Tests

Test Estimated completion time Description

SMBIOS Self-Test 1 second Checks the SMBIOS tables for 32-bit 
errors (type 18) and 64-bit errors (type 
33). Also verifies that the mapped-in 
DIMM size is appropriate for the slot 
it’s inserted into. If there’s a size 
mismatch, an error occurs.

Test Estimated completion time Description

ECC Error Count 1 second Reports the number of ECC errors, and 
then resets the count

Test Estimated completion time Description

Verify Motor +/– 10%, 
10 Reads High, 20 Low

2 minutes Verifies the minimum and maximum 
fan speeds. Sets the minimum and 
maximum builds within 10% of the 
threshold and then does 10 
consecutive reads at the maximum 
and 20 at the minimum.

Verify Motor Automatically +/
– 15%

2 minutes Verifies the minimum and maximum 
fan speeds. Sets the minimum and 
maximum builds within 15% of the 
threshold.
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Power Supply Tests

Sensor Tests

USB Tests
Connect USB devices before running USB tests.

Video Controller Tests
To run these tests, a display must be attached to any graphics cards being tested. The 
displays can’t be asleep. For example, if you have two graphics cards, they both need 
displays attached and both displays must not be asleep.

Test Estimated completion time Description

Good Bit 1 second Checks if the power supply’s good bit 
is set. If it’s not set, this could indicate 
that the power supply isn’t seated 
well, is bad, or that there’s no AC 
connected.

Quick 5 seconds This is available only if you have more 
than one power supply. This turns off 
the redundant power supplies so that 
only one is run on.

Test Estimated completion time Description

Sensor Reads 1 second Verifies that the sensor reads are 
within the preset sensor limits

Test Estimated completion time Description

Presence 1 second Verifies that a USB device is connected

Test Estimated completion time Description

OpenGL Point 10 seconds Verifies video controller using a 2D 
point test

OpenGL Line 10 seconds Verifies video controller using a 2D 
line test

OpenGL Triangle 10 seconds Verifies video controller using a 2D 
triangle test

OpenGL Quad 10 seconds Verifies video controller using a 2D 
quadrilateral test

OpenGL Quad with Texture 10 seconds Verifies video controller using a 2D 
textured quadrilateral test

OpenGL Rectangle 10 seconds Verifies video controller using a 2D 
rectangle test

OpenGL Cube 10 seconds Verifies video controller using a 3D 
cube test
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OpenGL Cube with Fog 10 seconds Verifies video controller using a 3D 
cube with fog test

OpenGL Wireframe 10 seconds Verifies video controller using a 3D 
wireframe test

OpenGL Solid Red Model 10 seconds Verifies video controller using a 3D 
solid red model test

OpenGL Solid Red Model 
with Fog

10 seconds Verifies video controller using a 3D 
solid red model with fog test

Test Estimated completion time Description
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